
Solution Manual for Hands on Virtual Computing 2nd 

Edition Simpson 1337101931 9781337101936 
 

Full link download: 

Test Bank: 

https://testbankpack.com/p/test-bank-for-hands-on-virtual-computing-2nd-edition-simpson-

1337101931-9781337101936/  

Solution Manual: 
 

https://testbankpack.com/p/solution-manual-for-hands-on-virtual-computing-2nd-edition-

simpson-1337101931-9781337101936/  
 
 
 

 
Hands-On Virtual Computing, 2e 

 

 
 

Chapter 2 Solutions 
 

 
 

Answers to the Chapter 2 Review Questions 
 

1.   What are the minimum hardware requirements for installing VirtualBox? 

 
c. x86 Intel or AMD processor with 512 MB RAM and 30 MB hard disk space 

 
2.   You can add existing virtual machines to the VirtualBox Manager by doing which of the 

following? (Choose all that apply.) 

b. Using the Create Virtual Machine Wizard 

d. Clicking the Machine, Add option 

3.   Which option on the guest OS window Machine menu shows total hard disk reads and writes? 

 
b. Session Information 

 
4.   How many snapshots can a virtual machine have?
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d. Limited only by available disk space 
 
5.   Which of the following is not a power option in the guest OS window Machine menu? c. Turn 

off 

6.   Which tab in the Settings dialog box is used to set the boot device order? b. System 

 
7.   Which of the following drive size types provides the best performance for virtual servers? a. 

 
Fixed size 

 
8.   What is the maximum number of virtual network adapters in VirtualBox? c. 4 

 
9.   What is the default key for returning keyboard and mouse control to the host computer? d. 

 
Right Ctrl 

 
10. Which of the following devices can be configured to use an image file? (Choose all that 

apply.) 

 
a. Floppy disk 

 
b. CD/DVD-ROM drive 

 
11. Which of the following is an advantage of installing Virtual Machine Additions? (Choose all that 

apply.) 

a. Improved video resolution on the virtual machine 
 

b. Ability to move the mouse pointer between virtual machines and the host c. Shared 

folders 

12. Which of the following settings can’t be changed when the virtual machine is running? (Choose 

 
all that apply.) 

 
b. Memory 

d. Sound 

13. A snapshot can be used to perform which of the following tasks? 

 
b. Save the virtual machine state. 

 
14. Which menu selection do you use to change the way the virtual machine keyboard shortcuts? b. 

 
File, Preferences, Input



15. Which of the following networking options allows the virtual machine to directly use the host’s 

 
network adapter? 

 
c. Bridged Adapter 

 
16. Which of the following disk modes will discard any changes when powered down? c. Immutable 

 
17. Which of the following disk options is available when using the wizard to create a virtual 

machine? (Choose all that apply.) 

b. Dynamically allocated 

d. Fixed size 

18. Which of the following best describes how to connect an ISO image to a virtual machine? 

 
c. Clicking the Devices, Optical Devices option in the guest OS window 

 
19. What file extension is used for a VirtualBox disk image file? 

 
b. VDI 

 
20. Which type of cloned virtual machine uses the least disk space? 

 
d. Linked clone



Tips and Solutions for Chapter 2 
 
Activity 2-1: Installing VirtualBox 

 
In this activity, students will install VirtualBox on their computers using the installer downloaded in 

 
Chapter 1, assuming it’s not already pre-installed in the lab. 

 
Activity 2-2: Creating a Virtual Machine for Windows Server 2016 

 
In this activity, a new virtual machine is created and configured for future OS installation. 

In Step 6, the default is 25 GB. 

Activity 2-3: Installing Windows Server 2016 as a Guest OS 
 
In this activity, Windows Server 2016 is installed on the previously created virtual machine. The steps 

assume the OS installation media is an ISO image. 

In Step 12, the administrator password is recorded for future reference. 

 
Activity 2-4: Setting Global Preferences 

 
In this activity, the global preferences dialog box for VirtualBox itself is examined. 

 
In Step 3, the default key combinations are Power Off: Ctrl+F, Host Key: Right Ctrl, Full-Screen Mode: 

Host+F. 

In Step 5, the default update release type is “Stable Release Versions.” 

 
In Step 6, the choices for Maximum Guest Screen Size are Automatic, None, and Hint. 

 
Activity 2-5: Working with Virtual Machine Settings 

 
In this activity, the possible settings for a specific virtual machine are examined. 

 
In Step 4, the Floppy should be unchecked under Settings, System, Motherboard, Boot Order. 

In Step 6, The IDE controller/CD should be assigned to a drive letter on the host computer. 

In Step 7, the possible audio controllers are Intel HD Audio, ICH AC97, and Sound Blaster 16. The audio 

should also be disabled. 

In Step 8, the default network adapter type is “Intel PRO/1000 MT Desktop (82540EM).”



Activity 2-6: Adding and Removing Virtual Machines 
 
In this activity, the previously created virtual machine is removed from the VirtualBox Manager (but not 

its files), and then re-added to the Manager. 

In Step 3, the path to the virtual machine is recorded to make it easier to re-add it later in Step 6. 
 
Activity 2-7: Installing Guest Additions on a Virtual Machine 

 
In this activity, the Guest Additions are installed on the virtual machine using the Install Guest Additions 

 
CD Image command which automatically mounts an ISO image included with VirtualBox. 

 
Activity 2-8: Working with Shared Folders 

 
In this activity, shared folders are used to provide the virtual machine access to the Desktop folder on the 

host computer. The guest OS will see the shared folder as a network share. 

Activity 2-9: Working with Snapshots 
 
In this activity, taking and reverting snapshots is demonstrated. A snapshot is created, the text file created 

in the previous activity is deleted, and then the snapshot is reverted back to, restoring the deleted file. The 

snapshot is then deleted so the next activity will work correctly. 

Activity 2-10: Working with the Virtual Media Manager 
 
In this activity, the immutable hard disk image file mode is demonstrated, and indirectly how to change 

hard disk image files. The disk image file must be released from the virtual machine before the mode is 

changed. The mode can then be changed, and the disk image reattached. A new text file is created, and 

when the virtual machine is powered down and on again the file is gone due to the immutable mode. The 

image mode is then changed back, it does not have to be released and re-added to go from immutable 

back to normal. 

In Step 4, the path to the image file is recorded to make it easier to re-add it later in Step 8. 

 
Activity 2-11: Creating a Cloned Virtual Machine 

 
In this activity, a clone of the student’s virtual machine is created and appears in the manager, and is then 

deleted. Depending on hard drive/network speed, a linked clone can be used instead as a full clone copies 

the entire disk image file.



Solutions to the Case Project Assignments 
 
Case Project 2-1: Documenting Guest Additions 

 
The computer lab staff at Superior Technical College wants you to give a presentation on using Guest 

Additions. Your presentation should include a handout describing its features (including which guest OSs 

it can be installed on) and how to use them to improve virtual machine operations in the computer lab. 

Solution: Students should include a brief description of features such as shared folders, drag-anddrop 

capabilities, improved video resolution, and so forth. 

Case Project 2-2: Using Clones 
 
An instructor at Superior Technical College is developing a Windows server course that includes student 

projects on server configuration, starting with an existing server and then configuring it to perform certain 

tasks. Write a brief report explaining how the instructor could use clones. 

Solution: Answers will vary, but in general, students’ reports should recommend using either full 

or linked clones – linked clones being more space efficient, full clones typically faster – so that 

students can start from the same point. 

Case Project 2-3: Comparing VMware Workstation and Oracle VirtualBox 
 
Write a brief report comparing the following features of VMware Workstation with similar features in 

 
VirtualBox: snapshots, cloning, and VMware Tools. 

 
Solution: Their reports should compare VMware Tools with VirtualBox Guest Additions. 
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Chapter 02 
 

Additional Activities and Case Projects Solutions 
 
 
 

Solutions to the Additional Activities: 
 

Activity 2-12: Transferring Files with Drag and Drop 
 
In this activity, a text file created on the virtual machine will be transferred to the host computer 

via drag and drop. This file is used in the next activity to demonstrate snapshots.
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Chapter 2 
 

Working with Oracle VM VirtualBox 5 
 

At a Glance   
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Lecture Notes   
 

Overview 
 

This chapter introduces students to VirtualBox for the desktop. While Oracle was a late 

entrant into the virtualization market and doesn’t have as large a market share as VMware 

or Microsoft, it has been rigorously developing and acquiring virtualization products in 

recent years to support users of its database software. 
 

 

Chapter Objectives 
 

•    Install Oracle VM VirtualBox 5 

•    Work with menu options in VirtualBox Manager 

•    Work with virtual machines in VirtualBox 
 

 

Teaching Tips 
 

Installing VirtualBox 
 

1.   Clarify the minimum requirements for an installation of VirtualBox.
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Installing VirtualBox in Windows 10 
 

1.   Note also that VirtualBox can be installed on Microsoft operating systems dating back 

to Windows XP, plus Mac OS X and Linux. . 
 

 

Creating a Virtual Machine 
 

1.   Step through the Create Virtual Machine wizard and note the items needed for each 

guest machine: 

a.   Name: make it descriptive 

b.   Type: operating system 

c.   Version: OS version 

2.   Accept the recommended memory amount or adjust it using the slider bar. 

3.   Configure the hard disk by selecting one of three options (see Figure 2-1): 

a.   Do not add a virtual hard disk 

b.   Create a virtual hard disk now 

c.   Use an existing virtual hard disk file 

 
Creating a Virtual Hard Disk File 

 
1.   Show the steps for configuring a hard disk file, beginning with file type. Describe the 

types displayed in Figure 2-2. 

2.   Explain the two options for hard disk file size and the benefits of each. Note Figure 2-3. 

a.   Dynamically allocated 

b.   Fixed 

3.   Lastly, identify the location and size of the virtual hard disk. 

Basic Virtual Machine Functions 
 

1.  Review basic functions, such as starting, designating control, display, and shutdown. 

 
Installing a Guest OS 

 
1.   Explain the three tasks for installing a guest OS: boot setup, connect an optical device, 

and choice of installation method. Utilize Figures 2-4 and 2-5. 
 

 

Working with the Virtual Box Manager 
 

1.   Point out the three areas of the Virtual Box Manager while displaying Figure 2-6. 

2.   The following sections provide details for these sections: 

a.   Toolbar 

b.   File menu 

c.   Machine menu 

 
Working with the Toolbar 

 
1.  Highlight commonly used functions of the toolbar: 

a.   New
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b.   Settings 

c.   Discard 

d.   Start 

 
Working with the File Menu 

 
1.   Discuss each of the File menu options: 

a.   Preferences (see Figure 2-7 and Table 2-1) 

b.   Import Appliance 

c.   Export Appliance 

d.   Virtual Media Manager 

e.   Network Operations Manager 

f.   Check for Updates 

g.   Reset All Warnings 

h.   Exit 

 
Working with the Machine Menu 

 
1.   Define each of the Machine menu options: 

a.   New 

b.   Add 

c.   Settings 

d.   Clone 

e.   Remove 

f.   Group 

g.   Start 

h.   Pause 

i.    Reset 

j.    Close 

k.   Discard Saved State 

l.    Show Log 

m.  Refresh 

n.   Show in Explorer 

o.   Create Shortcut on Desktop 

p.   Sort 

2.   Reference the Settings option and Figure 2-8. Detail the options: 

a.   General 

b.   System 

c.   Display 

d.   Storage 

e.   Audio 

f.   Network 

g.   Serial Ports 

h.   USB 

i.    Shared Folders 

j.    User Interface
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Teaching 

Tip 

VirtualBox began as a product of German company Innotek GmbH. Innotek was 

acquired by Sun Microsystems in 2008; Oracle acquired Sun in 2010.

 

Quick Quiz 1 
 

1.   (True or False) VirtualBox requires at least 25 MB of disk space.  Answer: 

False 

 
2.   The default format for a newly created virtual hard disk is           . 

Answer: VDI 

 
3.   When designating the amount of storage for a hard disk file, what are the 

two types that can be created? 

Answer: Dynamically allocated and Fixed. 
 

4.   How many serial ports can be added to a virtual machine?  Answer: Four 
 

 

Working with Virtual Machines in VirtualBox 
 

1.   Describe the details that appear on the start-up screen, and the options that can be set in 

the View menu. Use Figure 2-9 and Table 2-2 to demonstrate. 

 
Adding and Removing Virtual Machines 

 
1.   Explain the ease of adding and removing virtual machines, and the simple steps to 

accomplish both. 

 
Installing Guest Additions on a Virtual Machine 

 
1.   Review the beneficial features available after installing Guest Additions: 

a.   Mouse pointer integration 

b.   Shared folders 

c.   Better video support 

d.   Seamless windows 

e.   Generic host/guest communications 

f.   Time synchronization 

g.   Shared clipboard 

h.   Automated login 

 
Transferring Files with Shared Folders 

 
1.   Note that drag and drop file sharing is enabled with Guest Additions, simply by 

designated a shared folder on the host computer... 

 
Transferring Files with Drag and Drop 

 
1.   Explain the drag and drop functionality and the limits that can be enabled.
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Using Snapshots 
 

1.   Define snapshots and emphasize their value. Utilized Figure 2-10 to show how they are 

recorded and displayed in VirtualBox. 

 
Adding and Editing Virtual Hard Disks 

 
1.   Emphasize the capacity of a virtual machine running with a SATA controller. 

2.   Introduce the Virtual Media Manager with Figure 2-11. 

3.   Note that the Manager is used to copy, remove or modify images. Modifying images 

offers five modes: 

a.   Normal 

b.   Writethrough 

c.   Shareable 

d.   Immutable 

e.   Multi-attach 

 
Creating Clones 

 
1.   Explain the benefits of cloning virtual machines, and define the differences between 

full clone and linked clone. 

 
Configuring Network Settings 

 
1.   Point out that VirtualBox provides up to four virtual network adapters. Show Figure 2- 

12. 

2.   Detail the configuration options for each adapter: 

a.   Not attached 

b.   NAT 

c.   NAT Network 

d.   Bridged Adapter 

e.   Internal Network 

f.   Host-only Adapter 

g.   Generic Driver 

3.   Note adapters available. 

4.   Also note the use of MAC address as each adapter’s unique identifier. 
 
 

 

Quick Quiz 2 
 

1.   Multiple useful features and improved integration is enabled between host and 

guest PCs when          is installed.   Answer: Guest Additions 

 
2.   An exact copy of a virtual machine is a            . Answer: Full clone
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3.   (True or False) When configuring a system to utilize snapshots, it is necessary to 

identify the number of snapshots that will be stored and amount of space they can 

occupy before enabling the capability.  Answer: False 

 
4.   While an IDE controller can support up to four devices, a virtualized computer 

with a SATA controller can support up to          (number of devices). Answer: 30 
 
 
 

Class Discussion Topics 
 

1.   Discuss organizational environments where virtualization would not be recommended. 

 
2.   Discuss scenarios when network adapters on the same virtual machine might be 

configured differently than each other. 
 
 
 

Additional Projects 
 

1.   What are some of the applications developed and supported by Oracle that make 

virtualization technology mandatory or beneficial? 

 
2.   Where lab/classroom capabilities exist, install and configure VirtualBox on different 

generations of operating systems and identify differences. 

Additional Resources 
 

1.   VirtualBox home page:  https://www.virtualbox.org/ 
 

2.   Booting with ISO file: :  http://www.intowindows.com/how-to-boot-and-install-fromiso- 

in-virtualbox/ 
 

3.   Comparison of platform virtualization software: 

https://en.wikipedia.org/wiki/Comparison_of_platform_virtualization_software 
 
 

 

Key Terms 
 

   dynamically allocated A hard disk file type which will start out small and grow as is 

needed up to the maximum specified size. 

   fixed size A hard disk file type which will immediately consume the full size of the 

virtual hard disk on the host for maximum performance. 

   full clone A virtual machine with an exact copy of the original virtual machine’s disk 

files. 

   Host key Returns control of the mouse and keyboard to the host operating system. 

   Snapshots Preserves the current state of a virtual disk so it can be returned later even 

after many changes to the guest OS.

http://www.virtualbox.org/
http://www.intowindows.com/how-to-boot-and-install-fromiso-


 

 
 
 
 
 
 

 
Activities: 
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Additional Activities and Case Projects Additional

 

Activity 2-12: Transferring Files with Drag and Drop 
 
 

Time Required: Approximately 10 minutes 
 

 

Objective: Drag and drop a text file between the host computer and virtual machine. 
 

 

Description: In this activity, you practice using the drag and drop capability in Guest Additions 

to copy a file between the virtual machine and host computer. 

 

1.   If necessary, log on to your host computer with your administrative username and 

password and open the VirtualBox Manager. 

2.   Start the Windows Server 2016 virtual machine. Log on to the server using Right 

 
Ctrl+Del or clicking the Input, Keyboard, Insert Ctrl+Alt+Del menu option. 

 
3.   Click Devices, Drag and Drop in the VirtualBox guest OS window, then click the 

 
Bidirectional menu option. 

 
4.   To create a text document in the Windows guest OS, right-click the Desktop, point to 

 
New, and click Text Document. Type SampleData as the document name. 

 
5.   Double-click the SampleData file to open it in Notepad. Enter your name in the file, 

save the file, and then exit Notepad. 

6.   Drag the SampleData file from the guest OS to your host computer and open it to 

verify the contents. Power off the virtual machine and then leave the VirtualBox 

Manager open for the next activity. 


